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Table 2. collections of the Wisconsin State Herbarium (WIS). Numbers of specimens for each collection,
partitioned by geography, are estimates except for Wisconsin vascular plants. That exact number is known
because all specimens have been databased. In particular, notice WIS’ outstanding collections of North
American lichens and angiosperms, parasitic fungi, and Latin American angiosperms

Wisconsin North Latin Old TOTALS
America America World
Algae 140 3,120 40 170 3,470
Parasitic Fungi 37,800 36,900 3,300 22,000 100,000
Lichens 30,220 94,060 30,490 52,730 207,500
Bryophytes 13,510 33,140 2,050 11,190 59,890
SUBTOTAL.:

‘Cryptogams’ 81,679 | 167,220 35,880 86,090 385,860
Lyco+Pteridophytes 11,730 10,600 6,310 3,300 31,940
Gymnosperms 2,160 3,290 4,480 660 10,590
Angiosperms 238,070 | 340,730 119,400 73,160 771,360
Teaching Collection 16,000 16,000

SUBTOTAL:
Vascular Plants 267,960 354,620 130,190 77,120 814,890
TOTAL:
ALL GROUPS 349,630 | 521,840 166,070 163,210 1,200,750




Vascular plant data and images being contributed as part
of the Tri-trophic and Great Lakes TCN’s

Plants, Herbivores, and Parasitoids: A
Model System for the study of Tri-Trophic

Associations (2011)

http://tcn.amnh.org

Documenting the Occurrence
through Space and Time of Aquatic

’< Non-indigenous Fish, Mollusks,
Algae, and Plants Threatening North

America's Great Lakes (2014)



W! Tri-trophic Families
R p

Family ~_|WI specimens
Apiaceae | 3899
Asteracae et 33068
Chenopodiaceae | 1439
Cupressaceae 51 691
Cyperaceae o 23676|
Fabaceae (s.l.) 4 7712
Fagaceae _ 2094
Grossulariaceae | 1804
Juglandaceae _ 688
Lamiaceae . 6571
Oleaceae o o RN
Pinaceae ‘ 1261
Poaceae 1 20353
Polygonaceae _ 4943
Rhamnaceae @ | - 692
Rosaceae A 14283
Salicaceae ; 4640
Scrophulariaceae ; 5590
Solanaceae " 1379
Zygophyllaceae 1 6
TOTAL 135552




e All vascular plant specimens
from Wisconsin were
already barcoded and
databased prior to our
participation in the TCN’s

e Databasing was started in
1994 and label data was
entered into a Paradox7
(relational) database that
was developed in-house.

* Migrated to an Access
(flat file) database in (2000)
and then recently migrated
to Specify (relational) in
2012.




Table 1. Genera (and their corresponding family) targeted by this effort. Lists were generated

by querying NOAA’s GLANSIS database http://www.glerl.noaa.gov. ‘Watchlist’ genera not i ‘
hborid WO

{

)

PLANTS & ALGAE FISH MOLLUSKS

Genus Family Genus Family Genus Family |
Conium Apiaceae* Alosa Clupeidae Bithynia Bithyniidae
Cirsium Asteraceae™® Apeltes Gasterosteidae | Cipangopaludi | Viviparidae

na
Pluchea Asteraceae* Carassius Cyprinidae Corbicula Corbiculidae
Solidago Asteraceae* Cyprinus Cyprinidae Dreissena Dreissenidae
Impatiens Balsaminaceae Enneacanthus | Centrarchidae | Elimia Pleurocerida
e
Alnus Betulaceae Esox Esocidae Gillia Hydrobiidae
Myosotis Boraginaceae Gambusia Poeciliidae Lasmigona Unionidae
Nasturtium | Brassicaceae Gymnocephalu | Percidae Pisidium Sphaeriidae
s
Rorippa Brassicaceae Lepisosteus Lepisosteidac | Potamopyrgus | Hydrobiidae
Butomus Butomaceae Lepomis Centrarchidae | Radix Lymnaeidae
Cabomba Cabombaceae Misgurnus Cobitidae Sphaerium Pisidiidae
Mpyosoton Caryophyllaceae | Morone Moronidae Valvata Valvatidae
Chenopodiu | Chenopodiaceae*| Neogobius Gobiidae Viviparus Viviparidae
m
Carex Cyperaceae* Notropis Cyprinidae
Lupinus Fabaceae* Noturus Ictaluridae
Mpyriophyllu | Haloragaceae Oncorhynchus | Salmonidae
m
Hydrocharis | Hydrocharitaceae| Osmerus Osmeridae
Iris Iridaceae Petromyzon Petromyzontid
ae
Juncus Juncaceae Phenacobius Cyprinidae
Lycopus Lamiaceae* Proterorhinus | Gobiidae
Mentha Lamiaceae* Salmo Salmonidae
Lythrum Lythraceae Scardinius Cyprinidae
Marsilea Marsileaceae
Nymphoides | Menyanthaceae
Najas Najadaceae
Epilobium Onagraceae
Agrostis Poaceae*
Alopecurus | Poaceac*
Echinochloa | Poaceac*
Glyceria Poaceae*
Poa Poaceae*
Puccinellia | Poaceac*
Polygonum__| Polygonaceae*
Rumex Polygonaceae*
Potamogeton| Potamogetonacea
e
Lysimachia | Primulaceae
_g_Fran ula Rhamnaceae* Wisconsin: Dane County
Salix Salicaceac*
Veronica Scrophulariaceae
* (22 g 200y Gpaks. |

Solanum Solanaceae* i
Sparganium | Sparganiaceae
Trapa Trapaceae * = Plant family targeted by “tri-
Typha Typhaceae trophic” TCN . L0
Nitellopsis Characeae (algae) e

07N 09E 06 NW4NW4




Vascular plant specimens are being databased by student
workers entering the label information directly from specimens
into Specify workbench template

5p1 Specify 6.5.05 9 7 [ —c—
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Or by leveraging crowd sourcing label
transcription by volunteers

As specimens being imaged the resulting CR files are stored
in separate folders by genus.

CR files are too large (ca. 28,000KB/image) to export
directly to volunteers.

Large sets of CR files of images are turned directly into
JPEG’s using Adobe Bridge.

Volunteers’ enter the label data into an Excel spread sheet
based on Specify workbench template.



Converting CR image to JPEGs using Adobe Bridge

\/

*¢ Open Bridge.

% Select the folder with the Camera Raw Images then do Select All
(under Edit).

¢ Go to Tools and Select Photoshop > Image Processor.
» Seclect Folder (location where to save images)

¢ Select File Type

» Hit Run

» JPEGs will be saved in the folder you selected



= Computer > B Macintosh HD > @8 Users > g mfeist > ] Desktop > [ Convert Test >

PEAVORITES" FOLDERS

Computer
{
ﬁ mfeist
m Desktop
m Documents
m Pictures

FILTER |[FCOLLECTIONS"|

Batch03_Misfits (11)
Batch03_Misfits2 (4)

Redo (4)

11 items, 1 hidden

[COoNTENT |

v0293563WIS.CR2

v0293567WIS.CR2

v0293560WIS.CR2
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= Computer > I Macintosh HD ) f Users > @ mfeist > & Desktop > fll Convert Test )

FAVORITES'| FOLDERS

_; Computer

{

ﬁ mfeist
H Desktop
m Documents

H Pictures

FILTER [COLLECTIONS |
Batch03_Misfits (11)

Batch03_Misfits2 (4)

Redo (4)

11 items, 1 hidden
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dobe Photoshop CC

145%

Q> Search in Docume

Image Pr

' Select the images to process

Process files from Bridge only (10)
["]Open first image to apply settings

<) Select location to save processed images

(0)Save in Same Location

JUsers/mfeist/...p/Convert Test

1 File Type
[VISave as JPEG

Quality:

[ Convert Profile to sRGB

["]Save as PSD

[]Save as TIFF

.\ Preferences

["]Run Action: efault Act

e

¥ Include ICC Profile

[]Resize to Fit




JPEGs of entire image can be sent to volunteers (generally using DropBox)

Or further manipulation of images can be done to crop just the label (only works if
label is in the lower right hand corner) and the JPEGs of only the cropped labels can

be sent to volunteer.

{250 FILMSTRIP METADATA KEYWORDS
= Computer > Bl Macintosh HD > @ Users > ) mfeist > [E] Desktop > MW Convert Test > MW JPEG >
PAVORITES"| FOLDERS

™ Computer

R meist
5} Desktop

##9 pocuments
B9 pictures

FILTER [COLLECTIONS"|
BatchO3_Misfits (11)

Batch03_Misfits2 (4) Plants of Wisconsin

Redo (4) Plant Systematics Herbarium
= CACTACEAE

Optunia humifusa L

ith red center. Found

WISCONSIN, DANE County

South-facing slope of a cedar glade

T8N R6 E Section: 7

Collector: Jennifer Bradsby Num.: 31 Date: 4-28-2006

v0293560WIS Jpg

Auto

adows

Open Image




Cropping Labels Using Bridge

1) Open Bridge.
2) Open the folder of JPEGs.

3) Select one of the JPEGS, then choose File > Open in Camera Raw.

4) Crop it. Close Camera Raw.

5) Copy the settings from the cropped one (Edit > Develop Settings > Copy Camera Raw Settings)
select all the other images (Invert Selection), then choose Edit > Develop Settings > Paste

Camera Raw Settings.

6) A window will open “Paste Camera Raw Settings.” Under Subset choose Crop. Hit OK.

7) They should all be cropped the same way now.

8) Select all the cropped images. Under File select Open In Camera Raw. Select All. Hit Save

Image and Select Folder (where to save cropped images). Under Format select jpeg. Quality 5.
Hit Save.



[ JPEG - Adobe Bridge

essomas [T weronra wevworos - | [

= Computer > & Macintosh HD > B Users > @ mfeist > f& Desktop > Ml ConvertTest > il JPEG Sort by Filename
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Once Excel files are returned they
checked and verified by one of the
curators or by designated student to
ensure complete data capture.

Post data editing is especially
important if volunteer has only been
sent the cropped labels, as there is
often additional data elsewhere on the
sheet.

Once data is edited the Excel
files are imported into Specify
workbench and then uploaded
into database



e

G 67

80910,

copyright reserved

GIZ, OF WISCONSIY

HERBARIUM
.
MADISON (WIS)

INNER, WETTEST OF TE
a lakeshore wet mar:

SHEET 1 OF 3 SHEETS
WISCONSIN
Waukesha Co.
licaria L,

s wherever culvert
ge meadow water

EE ZONES SURROUNDING LAKES, 2
dominated by Typha lati- otz ty (ppm CaCo0,)
Southern Unit of Ketfle Moraine St. For

ific Area, 4% mi. (b

mpanuls 2pari- RITE, sec. 34 Wik of Wk
. Cochrane

Galium trifidum, Utricu-
T. S. Cochrane, w/ W. Tans & B. A

v,

i

7/ S T )
copyright reserved

[of 2

WISCONSIN
KEWAUNEE County

Lythrum salic

in the
st north of the tc
« & ft. tall.

(® 23N; R.25E Sect.18 ).SE:

Datetiuguse 11, 1971 No. 417

Oollector: Bruce & JoAnn Hansen




Prior to our participation in the Lichen & Bryophyte
TCN there were very few lichen (7500) or bryophyte (0)
specimens databased.

Since we were in the transition period between
database systems we weren’t be able to develop a
functioning database system to allow for rapid
databasing of these collections.

Separate barcode series for both lichen and
bryophytes. Barcodes are in different format from
those for the vascular plants.

The lichens and bryophytes are being imaged and
databased through the LBCC’ Symbiota portals:



North American Lichens and Bryophytes: Sensitive Indicators of

Environmental Quality and Change
http://lbccl.acis.ufl.edu

Consrtinn f
NORTH AMERICAN LICHEN HERBARIA

http://lichenportal.org/portal/

(onsortium of
NORTH ANERICAN BRIOPHYTE HERBARI

http://bryophyteportal.org/portal/




Digitization Workflow

to

Small Collections : > : : >
mail their specimens see

Imaging Institutions

=]

o |

Central Servers @&
image storage, database | _

web server, backup :
pre-processing

Consortia Portals
Editing/Transcription
Application

Editors/Transcribers
and Volunteers

[ W

HUB
GBIF and other
networks
Home institution’s
database and website




Digitization Workflow

o —_—

\

Central Processing
Take Image Upload to folder OCR

on FTP server Image processing NLP

Florida

Bulk processing
+ Preliminary
Create/Merge geo-referencing

Record in Portal
Create Skeleton Link Image

1
|
|
File Upload to folder I
on FTP server l
Florida I
I
|

Upload Record in
Portal

. Find Duplicates and
Link Image

Edit Record in Portal [j
Existing Digitized /
Records

Manage Records
in Portal

Approve Record

in Portal



* Images are saved directly as JPEGs.

A skeleton record set is created, that includes barcode number,
genus & specific epithet selected from pre-established thesaurus.

 Minimal geographic information is also entered (country & state).

093293

LICHENS OF MONTANA

Xanthomendoza oregana (Gyelnik) Sochting, Kaernefelt
& S. Kondr.

On Populus bark

Itch-kep-pe Park Campground, 1 mi SE of Columbus
Stillwater Co., MT

1145 m 45° 37°'N, 109° 18’'W

C.E. Seibert
5 May 2007
L178a

inthomendoza ful :
t Calob A. Morse, 2012 | O ) Sechting et al.
L. McGregor Herbarium (KANU)

\versity of Kansas, Lawrence, Kansas USA

e —



Each group of images (lichens and bryophytes) are processed separately since
they will be sent to different portals, but the images of the specimen labels

are all processed through the same steps.

Labels are batched and each evening they are run through an Optical
Character Recognition (OCR) program. Both and Tesseract (open source) and
ABBY were initially tested but ABBY produced better results.

The text generated by OCR is next run through natural language program
which parse’s the text into data fields.

Corresponding record is then generated that can be posted on the portal and
can be edited.



tana State University AHerbarium (MONT)

: >> Collection Management >> Editor

Occurrence Data Determination History

Genetic Links

Collector Info

Catslog Number ?  Other Numbers ?  Collector *

Number ° Date ?

MONT-L-0008067

Associated Collectors *

Verbatim Date *

Exsiccati Title

N

Number

Latest Identification
Scientific Name *

o

Author -

Xanthoparmelia coloradoensis

ID Quslifier *

Identified By *

Locality
Country State/Province

(Gyelnik) Hale

Family ° Parmeliaceae

Date Identified *

Municipslity

United States
Locality

Wyoming

N

Locality Security
Latitude Longitud Unc

Dstum ? Verbatim Cs di

Elevation in Meters Verbatim Elevation

E <<

Misc
Habitat

. @<)[ Tools |

Associsted Taxa

Description

Notes

Life Stage * Sex ?

Individual Count * ing Protocol ©  Pr

Phenology ? Establishment Means °

Curation

Type Status ? Disposition 2

Cultivated

Occurrence ID * Field Number *

Owner Code * Basis of Record *

Langusge

Label Project

PreservedSpecimen

Dupe Count Processing Status
Unprocessed v

N

Label Processing

 OCRmage | Options
OCR whole image
OCR w/ ansalysis

Image 1 of 1

i»;LICHENS OF YELLOWSTONE NATIONAL PARK

Xanthop is (Gyelnik) Hale Loosely attached to rock.
Mount Washburn; along trail from Chittenden Road, N side Park Co., WY
444°47'48", 1104°25'44". 2786m

Sharon Eversman 15 August 1556 S€082

lia col d

Notes:
Source:
ABBYY:2013-07-12
~ Save OCR Edits - Parse OCR (LBCC) 10f1
Delete OCR




ntana sState university nerbarium (MUN1)
me >> Collection Mansgement >> Editor

o, 3

Occumrence Data

Determination History l Images l Genetic Links l Admin ﬁ

Collector Info

Catalog Number ?  Other Numbers °  Collector °
MONT-L-0008067

Number ° Date *

Auto search
Associsted Collectors * Verbatim Date ”
V4

Exsiccati Title Number
Latest Identification
Scientific Name ” Author ?
Xanthoparmelia coloradoensis (Gyelnik) Hale

ID Qualifier * Family ? Parmeliaceae

Identified By ? Date Identified * V4
Locality
Country State/Province County Municipality
United States Wyoming
Locality

B Locality security
Latitude Longitude

Uncertainty 2

@) Tools |
Verbatim Elevation
<<

Elevation in Meters
Misc
Habitat

Datum * tim Coordinates

Associated Taxa

Description

Notes

“

Life Stage ” Sex ”

Individual Count *

N

Phenology ° Establishment Means *

Curation

Type Status ? Disposition ?

Cultivated

Field N ?

Owner Code * Basis of Record *

Language

Label Project

PreservedSpecimen

Dupe Count Processing Status

Unprocessed .

Primary Key: 1487182

Date Last Modified: 20123-07-28 18:48:19

Entered By:

Label P

OCRImage | Oviiors
OCR whole image
OCR w/ analysis

Image 1 of 1

i»;LICHENS OF YELLOWSTONE NATIONAL PARK

Xanthop 1lia cel d i=s (Gyelnik) Hale Loosely attached to rock.
Mount Washburn; along trail from Chittenden Road, N side Park Co., WY
444°47748", 1104°25'44". 2788m

Sharon Evers=man 15 August 1556 S€082

MNotes:

Source:

ABBYY:2013-07-12

Delete OCR

it AN

10of1




p &
ne >> Collection Management >> Editor

Occurrence Data Determination History l Images l Genetic Links l !

Collector Info

Catalog Number ©  Other Numbers ©  Collector * Number ° Date 7
MONT-L-0007935

Associsted Collectors * Verbatim Date *

Exsiccati Title Number

Latest Identification
Scientific Name * Author ?
Xanthomendoza fulva (Hoffm.) Sechting, Karnefelt

ID Qualifier ? Family  Teloschistaceae

o

Identified By ” Date Identified ~
Locality
Country State/Province County Municipality
United States Montana

oy rs

OCR whole image

Locslity Security OCR w/ analysis

Latitude Longitud: u ? Datum ? Verbatim C
iwzd;owa

.QLI‘-'.&LS_.‘ = LICHENS OF MONTANA
Elevsation in Meters Verbatim Elevation i g (Gyelnik) Scchting, Kaernefelt & 3. FKondr.
2 << Ve On Populu= bark
Itch-kep-pe Park Campground, 1 mi SE of Columbus Stillwater Co., MT
. 1145m  454° 373€™N, 1084° 163w
Misc C.E. Seibert S May 2007 L178a
Habitat Xanthomendoza fulva (Hoffm.) Sochting et al.

Det. Caleb A. Morse, 2012
R. L. McGregor Herbarium (KANU)
University of Kans=as, Lawrence, Kansa=s USA

Associated Taxa

A8
Description
Notes
V4
Life Sf ? Sex ? Individual Count ing Pr 17 P ?
i tage ivi Ul INotes:
Phenology ? Establishment Means ° Source:
- _ B
Cultivated ABBYY:2013-07-11
Curafion Save OCREdts | [ Parse OCR (LBCC) | L
Type Status * Disposition * Occurrence ID Field ?
Owner Code Basis of Record * Langusge Label Project

PreservedSpecimen

Dupe Count Processing Status
Unprocessed v

Primary Key: 1466472 Date Last Medified: 2012-07-26 18:48:19 Entered By:
Additional Options

Save E
Gt Autn 5ot [Not Activatad = [ Go to New Occurrence Record |




dontana State University Rerbarium (MONT) N
iome >> Collection Management >> Editor

u Occurrence Data u Determination History I [ ic Links I
Collector Info
Catalog Number Other N 7 Coll ? Number > Date 7
MONT-L-0007935
Associated Collectors * Verbatim Date ©
»
Exsiccati Title Number
Latest Identification
Scientific Name Author ?
Xanthomendoza fulva (Hoffm.) Sechting, Karnefelt
ID Qualifier * Family ° Teloschistaceae
Identifies By * [Caleb A Morse | Date ldentifies * ¥
Locality
Country State/Province County Municipality
United States Montana
Locy Opdrs
OCR whole image
Locslity Securi analysis
ty ty OCR w/ analysi
Latitude Longi [ inty ? Datum ? \ im C.
= inzd;0W3
@[ Tools = LICHENS OF MONTANA
Elevation in Meters Verbatim Elevation Xanth (Gyelnik} Sochting, Kaermefelt & 3. Kondr.
S slmn WY e
o= Itch—kep-pe Park Campground, 1 mi SE of Columbus Stillwater Co., MT
) 1145m  454° 373€™N, 1084° 1636w
Misc C_E. Seibert 5 May 2007 L178a
Habitat Xanthomendoza fulva (Hoffm.) Sochting et al.
Det. Caleb A. Morse, 2012
R. L. McGregor Herbarium (KANU)
Substrate University of K L K Usa
Associated Taxa
=]
Desciption
Notes
B
Life Stage ° Sex ? Individual Count ? ing Pr 12 F ions *
Cs Notes:
a 2 M a
RS = Cultivated :
ABBYY:2013-07-11
Curston [SeveOCREds | [ Fare OCALECD) ) S
Type Status ° Disposition ” O ID*? Field Number ?
Owner Code ” Basis of Record Language Label Project
PreservedSpecimen
Dupe Count Processing Status
Unprocessed -
Primary Key: 1468472 Date Last Modified: 2012-07-28 18:48:19 Entered By:
Additional Options
Statie Anto-Sat Nof Activafad [ o to New Occurrence Record |




Number of WIS specimens entered in Symbiota databases
as of 01 Oct 2014

Bryophyte Lichens
Collection Statistics Collection Statistics
32846 specimens 105149 specimens
0% georeferenced 42% georeferenced
100% with images 94% with images

132 families 124 families
494 genera 608 genera
1827 species 5182 species

Our long term goal is to have all bryophyte, lichen, and
vascular plant data and specimen 1mages 1in one Specity
database.



